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บทบรรณาธิการ

หากจะกล่าวถึงการพัฒนาเว็บไซต์ในโลกออนไลน์ปัจจุบัน จะเห็นได้ว่ามีเครื่องมือที่ 

ช่วยให้เราสามารถพัฒนาเว็บมีมากมาย และคงไม่มีใครปฏิเสธว่า Microsoft Visual Studio 

เป็นเครื่องมือที่มีความสะดวกในการใช้งาน และมีขีดความสามารถที่ไม่เป็นรองเครื่องมือใดๆ จึง

ท�ำให ้Microsoft Visual Studio ได้รบัความนยิมในระดบัตน้ๆ ของเครื่องมอืที่ใช้พฒันาเวบ็ไซต์ที่มอียู่ 

ซึ่งปัจจบุนัเป็นเวอร์ชนั Microsoft Visual Studio 2010 ซึ่งมาพร้อมกบั ASP.NET 4.0

เวบ็ไซต์ที่พฒันาด้วย ASP.NET 4.0 สามารถเลอืกเขยีนโค้ดก�ำหนดการท�ำงานได้ 2 ภาษา คอื 

Visual Basic 2010 และ Visual C# 2010 ซึ่งให้ผลการท�ำงานเหมือนกัน ขึ้นอยู่กับว่าผู้อ่านจะมี

ความถนดัหรอืมคีวามสนใจในภาษาใด อกีทั้งผู้อ่านท่านใดที่มปีระสบกาณ์ในการใช้งาน ASP ใน

เวอร์ชันก่อนหน้านี้ก็สามารถปรับใช้กับ ASP.NET 4.0 ได้เช่นกัน เนื่องจากโครงสร้างของภาษา 

มคีวามแตกต่างกนัไม่มากนกั โดยที่ ASP.NET 4.0 จะเพิ่มขดีความสามารถให้มากกว่าเวอร์ชนัก่อน 

เพื่อให้ง่ายส�ำหรบัผู้อ่านมากยิ่งขึ้น

หนงัสอืเล่มนี้ได้กล่าวถงึหลกัการพฒันาเวบ็ไซต์ที่มคีวามส�ำคญัส�ำหรบัผูท้ี่ต้องการใช้งาน 

ASP.NET 4.0 รวมถงึพื้นฐานต่างๆ ที่ผู้อ่านควรรู้ พร้อมกบั workshops มากมายให้ผู้อ่านได้เรยีนรู้

และทดลองท�ำ ซึ่งเราได้น�ำเสนอไว้ทั้ง 2 ภาษาคอื Visual Basic 2010 และ Visual C# 2010 

ทางทีมงานหวังเป็นอย่างยิ่งว่าหนังสือเล่มนี้จะมีส่วนช่วยให้ผู้อ่านมีความเข้าใจและ

สามารถพฒันาเวบ็ไซต์ด้วย ASP.NET 4.0 ได้เป็นอย่างด ีหากพบข้อผดิพลาดประการใดสามารถ 

ตชิมกลบัมาทางทมีงาน เพื่อให้เราได้ปรบัปรงุผลงานให้มปีระสทิธภิาพมากยิ่งขึ้น

ทมีงาน DEV BOOK ขอขอบคณุท่านผูอ่้านทกุท่านที่ให้ความสนบัสนนุเราในการสร้างสรรค์

ผลงานเขยีนที่ดมีคีณุภาพ

ด้วยความเคารพอย่างสูง

กตินินัท์ พลสวสัดิ์



คำ�นำ�

หนงัสอื BASIC ASP.NET 4.0 เล่มนี้ เป็นเล่มแรกของหนงัสอืในซรีสี์พฒันาเวบ็แอพพลเิคชนัด้วย 

ASP.NET 4.0 น�ำเสนอเนื้อหาส�ำหรบัคณุผู้อ่านที่เป็นมอืใหม่ในโลกของ .NET 4.0 (Visual Studio 2010) คลอบ

คลมุไปจนกระทั่งถงึการน�ำเสนอตวัอย่างการสร้างเวบ็ไซต์แบบง่ายๆ โดยใช้เวลาการเรยีนรู้ไม่นานนกั

หนงัสอืเล่มนี้เป็นคูม่อืน�ำทางได้ในระดบัหนึ่งว่า สิ่งที่ต้องรูเ้ป็นล�ำดบัแรกๆ ของการสร้างเวบ็ไซต์ขึ้น

มาด้วย ASP.NET 4.0 ว่ามอีะไรบ้าง ซึ่งผูเ้ขยีนคดิว่าเป็นค�ำถามที่หลายๆ คนต้องการทราบ แน่นอนว่า หนงัสอื

เพียง 1 เล่มไม่สามารถน�ำเสนอได้อย่างครบถ้วน แต่อย่างน้อยที่สุดถ้ายึดถือจุดที่ว่า น�ำเสนอเท่าที่จ�ำเป็น 

เท่าที่ควรทราบ เท่าที่ต้องรู้ กน็่าจะเป็นหนทางเริ่มต้นที่ด ีและยั่งยนื

ท้ายที่สุดนี้ผู้เขียนขอขอบคุณคุณผู้อ่านทุกท่านที่ให้ความสนใจผลงานของผู้เขียน รวมไปถึงได้ให้

ความกรณุาสอบถาม แนะน�ำ ตติงิจากผลงานที่ผ่านมาจากทกุช่องทาง ไม่ว่าจะเป็นอเีมล, MSN หรอืหน้า

เวบ็บอร์ดของเวบ็ไซต์ส�ำนกัพมิพ์ ผู้เขยีนต้องขอขอบคณุเป็นอย่างสูงมา ณ โอกาสนี้ด้วยครบั

และที่ลมืไม่ได้เลยกค็อื ผูเ้ขยีนขอขอบคณุ คณุสจัจะ จรสัรุง่รววีร ที่ได้ให้โอกาสผูเ้ขยีนจดัท�ำหนงัสอื

ในซรีสี์ .NET 4.0 ทั้ง Windows และ Web Application อกีครั้งหนึ่งครบั

ศภุชยั สมพานชิ

thaivb@yahoo.com (MSN),

thaivb.net@gmail.com
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หนงัสอื Basic ASP.NET 4.0 เล่มนี้เป็นหนงัสอืเล่มแรกในซรีสี์ของการพฒันา Web Application ด้วย 

ASP.NET 4.0 ส�ำหรบัผู้อ่านที่เป็นมอืใหม่ที่ยงัไม่เคยใช้ .NET มาก่อน

ปัญหาที่ส�ำคญัอย่างหนึ่งของผู้อ่านที่ยงัไม่เคยท�ำเวบ็ไซต์ด้วย ASP.NET 4.0 มาก่อนเลยกค็อืไม่รู้ว่า 

จะเริ่มต้นอย่างไรด ีเพื่อให้ได้ผลงานออกมาเรว็ที่สดุเท่าที่จะเป็นไปได้ อาจจะไม่ดเีด่นเท่าไรนกั แต่อย่างน้อย

ที่สดุกอ็ยากให้จบัต้องได้เป็นชิ้นเป็นอนัได้ในระดบัหนึ่ง

เนื้อหาของหนังสือเล่มนี้เริ่มต้นด้วยเนื้อหาขั้นพื้นฐานเท่าที่ควรทราบ ไต่ระดับไปเรื่อยๆ จนกระทั่ง

สร้างเว็บไซต์ที่ผู้เขียนคิดว่าเป็นแบบฝึกหัดที่ดี ก่อนที่จะเข้าสู่การสร้างเว็บไซต์ที่มีความสมบูรณ์ทั้งโครงสร้าง 

และประสทิธภิาพในล�ำดบัถดัไป

แนวทางการน�ำเสนอของซีรีส์หนังสือ ASP.NET 4.0
เนื่องจากรายละเอยีดของ ASP.NET 4.0 ที่มากบั VS 2010 มเีนื้อหาค่อนข้างเยอะพอสมควร ผู้เขยีน

จงึแบ่งหนงัสอืในซรีสี์ของ ASP.NET 4.0 ออกเป็น 2 Step นั่นคอื

1.	 เนื้อหาและรายละเอยีดต่างๆ ที่มากบั ASP.NET 4.0 แยกออกเป็น 4 เล่ม ได้แก่

�� �ASP.NET 4.0 #1 Beginning เป็นการน�ำเสนอพื้นฐานต่างๆ ส�ำหรบัผูอ่้านที่เป็นมอืใหม่ในโลก

ของ ASP.NET 4.0 ที่ควรทราบในขั้นต้น ไปจนกระทั่งน�ำเนื้อหาของบทแรกๆ เข้ามาประกอบ

กันเป็นแบบฝึกหัดในการสร้างเว็บไซต์อย่างง่าย เพื่อให้ผู้อ่านเห็นผลงานโดยใช้ระยะเวลา

เริ่มต้นไม่นานจนเกนิไป

�� �ASP.NET 4.0 #2 AJAX การท�ำเวบ็ไซต์ให้ส�ำเรจ็เพยีงอย่างเดยีวไม่ใช่ค�ำตอบของการท�ำเวบ็

ในยุคปัจจุบัน หนทางหนึ่งที่สามารถปรับปรุงเว็บไซต์ให้ดียิ่งขึ้นก็คือ การใช้เทคนิค AJAX 

ประกอบด้วย

yy การใช้งานภาษา JavaScript เพื่อแบ่งเบาภาระงานของฝั่ง Server ให้ฝั่ง Client เป็นผู้

กระท�ำบ้าง

yy การน�ำเทคนคิการประมวลผลระหว่างฝั่ง Server กบัฝั่ง Client โดยอาศยัภาษา JavaScript 

เข้ามาปรบัปรงุการท�ำงานให้มปีระสทิธภิาพมากยิ่งขึ้นที่เรยีกว่า AJAX

ก้าวแรกสู่ ASP.NET 4.0
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�� �ASP.NET 4.0 #3 jQuery, HTML 5, CSS3 และ Silverlight 4.0 ประกอบด้วย

yy JavaScript Framework ที่ชื่อว่า jQuery มดีอีย่างไร จงึท�ำให้ไมโครซอฟท์น�ำเข้ามาใช้งาน

ร่วมกบั ASP.NET 4.0 

yy การน�ำมาตรฐานเวบ็ใหม่ HTML 5 เข้ามาใช้งานร่วมกบั ASP.NET 4.0 ส่งผลให้ข้อมูลที่

ปรากฏอยู่ในบราวเซอร์ไม่ใช่เพยีงแค่การแสดงผลเหมอืนภาษา HTML 4.0 เดมิอกีต่อไป 

แต่ยงัสามารถอธบิายได้ด้วยว่า ข้อมูลที่ก�ำลงัน�ำเสนออยู่คอือะไร

yy การสร้างเวบ็ไซต์แบบ Rich Internet Application (RIA) ด้วย Silverlight 4.0 จะท�ำให้โลก

ของเวบ็ไซต์กบัโลกของ Windows Application ขยบัเข้าใกล้กนัมากยิ่งขึ้น

�� �ASP.NET 4.0 #4 MVC 3.0 Framework & Microsoft WebMatrix ประกอบด้วย

yy เนื้อหาที่ว่าด้วยเรื่องของการจดัโครงสร้างเวบ็ใหม่ โดยอาศยั MVC 3.0 Framework ซึ่งมากบั 

.NET 4.0 Framework

yy Microsoft WebMatrix เป็น Platform ที่เข้ามาปรบัปรงุโครงสร้างของภาษา ASP.NET 4.0 

ให้เข้าสู่มาตรฐานของภาษา HTML 5 อย่างแท้จรงิ

yy ปรบัปรงุโครงสร้างของภาษา ASP.NET 4.0 โดยใช้ Engine ตวัใหม่เพื่อรวมส่วนแสดงผล 

(*.aspx) เข้ากบัโค้ดการท�ำงาน (*.vb หรอื *.cs) เข้าเป็นหนึ่งเดยีว (*.vbhtml หรอื *.cshtml) 

2.	 การน�ำเนื้อหาที่น�ำเสนอใน 4 เล่มข้างต้นเข้ามาสู่การท�ำเวบ็ไซต์ที่เป็น Workshop อย่างแท้จรงิ

วิธีการน�ำเสนอของหนังสือเล่มนี้
ผู้เขยีนน�ำเสนอเนื้อหาการใช้งาน ASP.NET 4.0 ทั้ง 2 ภาษาโดยอาศยั VS 2010 นั่นคอื ภาษา  VB 

2010 และภาษา VC# 2010 โดยที่บางตวัอย่างจะลงโค้ดทั้ง 2 ภาษา โดยที่ลงภาษา VB 2010 เป็นล�ำดบัแรก 

ตามด้วยภาษา VC# 2010 อยู่ภายในเครื่องหมายวงเลบ็

บางตัวอย่างผู้เขียนเลือกลงโค้ดภาษาใดภาษาหนึ่งเท่านั้นเพื่อให้กระชับต่อการน�ำเสนอ โดยมีจุด

ตดัสนิใจที่ว่า โค้ดชดุนั้นๆ ภาษาใดมปีระเดน็ที่น่าสนใจมากกว่ากนั 

ในกรณทีี่ไม่มคีวามแตกต่างในส่วนของการท�ำงานของโค้ด ผู้เขยีนกจ็ะลงโค้ดของภาษา VB 2010 

เพยีงภาษาเดยีวเป็นหลกั ผูเ้ขยีนคดิว่าไวยากรณ์ของภาษา VB 2010 ไม่เป็นปัญหาต่อผูอ่้านที่สนใจภาษา VC# 

2010 โดยที่ตวัอย่างโค้ดที่อยู่ใน CD-ROM มคีรบทั้ง 2 ภาษาทกุตวัอย่างอยู่ในโฟลเดอร์ VB และ CS 

โดยที่ผูเ้ขยีนใช้โปรแกรม Visual Studio 2010 Ultimate Edition เรยีกสั้นๆ ว่า VS 2010 IDE เป็น Edition 

ที่ใหญ่ที่สดุเป็นหลกั ในกรณทีี่ผู้อ่านใช้ Edition อื่นที่ไม่ตรงกบัผู้เขยีนอาจจะมรีายการเมนูไม่ครบตามรูปภาพ

ที่ลงในหนงัสอืเล่มนี้ 

สครปิต์ที่ผู้เขยีนน�ำลงในหนงัสอืไม่มีโค้ดที่เกดิจากการใช้ค�ำสั่ง Auto Format... ซึ่งท�ำหน้าที่ตกแต่ง 

ให้เวบ็คอนโทรลต่างๆ เช่น GridView, DataList ฯลฯ ให้สวยงามขึ้น เพราะว่าเมื่อน�ำลงในหนงัสอืแล้วจะท�ำให้

ผู้อ่านดูสครปิต์ของหน้าเวบ็เพจ *.aspx ค่อนข้างล�ำบาก ผู้เขยีนถอืว่าเป็นสครปิต์ที่ถูกสร้างขึ้นมาโดยอตัโนมตั ิ

ไม่ใช่ส่วนที่ต้องการน�ำเสนอแต่อย่างใด



บทที่ 1 ก้าวแรกสู่ ASP.NET 4.0

5
Part 1 พื้นฐาน ASP.N

ET 4.0 

ผู้เขียนต้องการน�ำเสนอเฉพาะเนื้อหาหลักของหัวข้อดังกล่าวเป็นส�ำคัญ ส่วนโค้ดที่เกิดจากค�ำสั่ง

ส�ำเรจ็รูปเหล่านี้ผู้อ่านสามารถศกึษาเพิ่มเตมิเองได้ในภายหลงัอยู่แล้ว

ในหลายๆ หวัข้อมกีารท�ำงานสมัพนัธ์กนัระหว่างส่วนแสดงผล ซึ่งเป็นหน้าที่ของสครปิต์ ASP.NET 4.0 

(*.aspx) กบัโค้ดการท�ำงาน (*.vb หรอื *.cs) เมื่อผู้เขยีนใช้ค�ำว่า คณุสมบัต ิหมายถงึ การมองเวบ็คอนโทรล 

หรอืออบเจก็ต์ที่ก�ำลงัเรยีกใช้อยู่ในมุมมองของโค้ดท�ำงาน และใช้ค�ำว่า แอตทรบิวิต์ เมื่อมองในฐานะอลิเิมนต์ 

ตวัหนึ่งของสครปิต์ ASP.NET 4.0 แต่ทั้ง 2 ค�ำที่กล่าวมาหมายถงึสิ่งเดยีวกนั

กว่าจะมาเป็น Web 2.0
ในปัจจบุนัเวบ็ไซต์จ�ำนวนมากมายขยบัเข้าสูส่ิ่งที่เราเรยีกว่า Web 2.0 เตบิโตมาพร้อมกบัอนิเทอร์เนต็

ความเร็วสูง เราจะมาดูว่าประวัติความเป็นมาเป็นอย่างไร ข้อจ�ำกัดของผู้เขียนก็คือ ไม่สามารถน�ำเสนอ 

รายละเอียดความเป็นมาได้อย่างครบถ้วน หรือสมบูรณ์แบบ เพียงแต่น�ำเสนอจุดเปลี่ยนที่ส�ำคัญที่น่าสนใจ 

ผู้อ่านสามารถศกึษาค้นคว้าเพิ่มเตมิในแต่ละช่วงเวลาเพื่อให้ได้สาระที่ครบถ้วน และถูกต้องยิ่งขึ้น

ผู้เขียนขอแบ่งช่วงของการพัฒนาเว็บไซต์ออกเป็น 4 ช่วงใหญ่ๆ โดยใช้หลักการท�ำงานเป็นเกณฑ์

ของการแบ่งในแต่ละยคุ ดงันี้

ยุคที่ 1 Web 1.0 (Client Side Script)
ในยคุเริ่มแรกของเครอืข่ายอนิเทอร์เนต็ เวบ็ไซต์ถกูสร้างขึ้นมาด้วยภาษา HyperText Markup Language 

เรยีกสั้นๆ ว่า ภาษา HTML (นามสกลุ *.htm หรอื *.html) เป็นภาษาที่ท�ำงานด้าน Client (Browser) ทั้งหมด 100% 

ผูท้ี่สร้างเวบ็ไซต์ขึ้นมาเป็นผูก้�ำหนดว่าต้องการน�ำเสนอข้อมลู เนื้อหา สาระ (Contents) อะไรบ้าง ผูใ้ช้ 

ไม่มสี่วนร่วมใดๆ ทั้งสิ้นกบัเนื้อหาดงักล่าว ผู้เข้าเยี่ยมชมเวบ็ไซต์อยู่ในฐานะเป็นผู้เสพข่าวสารที่สนใจเท่านั้น

ภาษา HTML 1.0 ถูกสร้างขึ้นมาเพื่อก�ำหนดมาตรฐานของเอกสารที่แสดงในเวบ็ไซต์ โดยองค์กรที่

ชื่อว่า W3C (www.w3.org) ถูกพฒันาเรื่อยมาจนกระทั่งถงึยคุของภาษา HTML 3.2 ถูกสร้างขึ้นมาเพื่อก�ำหนด

ให้ภาษา HTML เป็นมาตรฐานกลางของการแสดงผลในบราวเซอร์

ในยคุของภาษา HTML 3.2 มบีราวเซอร์ยกัษ์ใหญ่ 2 รายคอื Internet Explorer กบั Netscape Navigator 

ครอบครองอยู่ ถอืเป็นยคุรุ่งเรอืงที่สดุของบราวเซอร์ Netscape Navigator อย่างแท้จรงิ 

ช่วงเวลาดงักล่าวแม้ว่าองค์กร W3C จะเป็นผู้ก�ำหนดมาตรฐานของเอกสารที่แสดงบนเว็บผ่านทาง

ภาษา HTML 3.2 กจ็รงิอยู ่แต่ผูผ้ลติบราวเซอร์ยกัษ์ใหญ่ทั้ง 2 ต่างกส็ร้างมาตรฐานของตวัเองขึ้นมา เพื่อให้การ 

แสดงข้อมูลในเวบ็เพจให้แตกต่างไปจากมาตรฐานกลางของภาษา HTML 3.2 จงึเป็นที่มาของปัญหาที่ว่า 

ถ้าใช้มาตรฐานของบริษัทหนึ่งก็จะแสดงผลในบราวเซอร์ของอีกบริษัทหนึ่งไม่ได้ หรือแสดงผล 

ผดิพลาด ในยคุนี้เกดิภาษาสครปิต์ที่ช่วยให้การแสดงผลในเวบ็เพจดขีึ้น 3 ภาษาคอื ภาษา JavaScript, ภาษา 

VBScript ผู้เขยีนขอกล่าวรวมถงึภาษา CSS (Cascading Style Sheets) ด้วย 

ในยคุนี้เองมคี�ำศพัท์เกดิขึ้นมา 1 ค�ำคอื ค�ำว่า Cross Browser ซึ่งหมายถงึ การสร้างเวบ็เพจขึ้นมา 

สามารถแสดงผลได้อย่างถูกต้องทั้งใน Internet Explorer กบั Netscape Navigator
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ยุคที่ 2 Web 1.5 (Server Side Script)
ต่อมาองค์กร W3C ก�ำหนดมาตรฐานของภาษา HTML เข้าสู่เวอร์ชนั 4.0 ท่ามกลางความขดัแย้ง

ของมาตรฐานการแสดงผลในหน้าเวบ็เพจของบราวเซอร์ทั้ง 2 ค่าย 

ในยคุนี้เกดิเทคโนโลยทีี่เรยีกว่า Flash ขึ้นมา ความมหศัจรรย์ของเทคโนโลย ีFlash กค็อื สามารถ

แสดงข้อมูลที่นอกเหนอืไปจากข้อความและรูปภาพธรรมดาของภาษา HTML ไฟล์ขนาดไม่กี่สบิไบต์สามารถ

โต้ตอบกบัผู้ใช้ได้อย่างน่าสนใจ และยิ่งใหญ่ต่อเนื่องมาจนยคุปัจจบุนั

ข้อจ�ำกดัของภาษา HTML 4.0 กค็อื เป็นภาษาที่ท�ำงานด้าน Client ทั้งหมด ไม่สามารถรองรบัการ

สร้างเวบ็ไซต์ที่เตบิโตอย่างก้าวกระโดดได้อกีต่อไป จงึเกดิภาษาที่ท�ำหน้าที่ทางฝั่ง Server (Web Server) ขึ้นมา 

ภาษาที่จดัอยู่ในยคุบกุเบกิที่ส�ำคญั ได้แก่ ภาษา CGI, PHP, ASP, JSP ฯลฯ ภาษาเหล่านี้ท�ำงานทางฝั่ง Server 

ทั้งหมด 100% เช่นกนั

หลกัการท�ำงานกค็อื Web Server จะแปลภาษาเหล่านี้ให้เป็นภาษา HTML ก่อนแล้วส่งกลบัมายงัฝ่ัง 

ผู้ใช้ (Client) เพื่อแสดงผลในบราวเซอร์ในล�ำดบัต่อมา

ภาษาที่ท�ำงานทางฝ่ัง Server เหล่านี้ช่วยให้การสร้างเวบ็ไซต์แตกต่างไปจากเดมิอย่างสิ้นเชงิ เจ้าของ

เวบ็ไซต์ไม่จ�ำเป็นต้องน�ำเสนอเนื้อหาแต่เพยีงฝ่ายเดยีวอกีต่อไป เปิดโอกาสให้ผู้ใช้เป็นผู้น�ำเสนอเนื้อหาได้บ้าง 

เว็บไซต์จ�ำพวกนี้ในยุคบกุเบกิ ได้แก่ การเซน็สมดุเยี่ยมเวบ็ไซต์ (GuestBook), เวบ็บอร์ด (Webboard), การเขยีน

สมดุบนัทกึ (Diary Online) ฯลฯ

ในยคุนี้เองที่ผูเ้ยี่ยมชมเวบ็ไซต์มส่ีวนร่วมของเนื้อหาในเวบ็ไซต์มากยิ่งขึ้น อาจกล่าวได้ว่าเป็นเจ้าของ

เนื้อหาสาระที่อยู่ในเวบ็ไซต์ในระดบัหนึ่ง

ไมโครซอฟท์พฒันา ASP ให้เข้ามาสู่ยคุของ .NET Framework ส่งผลให้ ASP เดมิซึ่งเรยีกว่า ASP 

Classic ถูกภาษา ASP.NET เข้ามาท�ำหน้าที่รับผดิชอบการพฒันา Web Application ด้วย .NET Framework แทน

1.0 2.0

ระดับความสามารถ

ช่วงเวลา (ยุค)

HTML 1.0

HTML 3.0
Java Scripts, 
VB Scripts

HTML 4.0
Flash, PHP, 
ASP, JSP

A JAR, XML

1.5
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Part 1 พื้นฐาน ASP.N

ET 4.0 

ยุคที่ 3 Web 2.0 (AJAX)
จากที่ผู้เขยีนกล่าวไว้ว่า ใช้หลกัการท�ำงานเป็นเกณฑ์ในการแบ่งแต่ละยคุ อาจกล่าวโดยสรปุได้ว่า
1.	 ยุค Web 1.0 ภาษาของยคุนี้ท�ำงานทางฝั่ง Client (Browser) ทั้งหมด
2.	 ยุค Web 1.5 ภาษาของยคุนี้ท�ำงานทางฝั่ง Server (Web Server) ทั้งหมด

เห็นได้ว่าหลักการท�ำงานเปลี่ยนจากประมวลผลฝั่ง Client (ยุค Web 1.0) เข้ามาสู่ประมวลผลฝั่ง 

Server ทั้งหมด (Web 1.5) เราจะมาดวู่าการย้ายทกุสิ่งทกุอย่างไปประมวลผลฝ่ัง Server ทั้งหมดกม็ข้ีอเสยีเช่นกนั

ภาษาที่ท�ำงานฝั่ง Server ช่วยให้การสร้างเวบ็ไซต์แตกต่างไปจากเดมิมากมาย ท�ำให้ผู้ใช้มสี่วนร่วม

มากขึ้นกจ็รงิอยู ่แต่การย้ายทกุสิ่งทกุอย่างไปฝ่ัง Server ทั้งหมดจงึเกดิค�ำถามตามมาว่าท�ำไมเราจงึไม่แบ่งงาน

บางอย่างมาให้ฝั่ง Client ท�ำงานบ้าง

ด้วยเหตขุ้างต้นจงึเกดิเทคนคิที่เรยีกว่า Asynchronous JavaScript And XML เรยีกสั้นๆ ว่า AJAX 

(เอ-แจก็ซ์ หรอือา-แจก็ซ์) หลกัการของเทคนคินี้กค็อื ใช้ภาษา JavaScript เข้ามาช่วยแบ่งเบาภาระการท�ำงาน

ของภาษาที่ท�ำงานฝั่ง Server 

หลกัการท�ำงานของเทคนคิ AJAX มอียู่ 2 ประการคอื
1.	 แบ่งงานให้ฝั่ง Client ประมวลผล เช่น แบ่งงานบางอย่างให้ฝั่ง Client ท�ำ
2.	 ถ้าเป็นงานของฝั่ง Server ให้ประมวลผลเท่าที่จ�ำเป็น หมายความว่า ให้ฝั่ง Server ท�ำเท่าที่ 

ควรจะท�ำไม่ใช่ท�ำทั้งหมด 

ในยุคนี้เองที่ประชากรของอินเทอร์เน็ต สามารถเข้าถึงอินเทอร์เน็ตความเร็วสูงอย่างแพร่หลาย จึง

ท�ำให้เวบ็ไซต์ต่างๆ สามารถน�ำเสนอข้อมูล ข่าวสารในรูปแบบต่างๆ มากมาย เช่น การน�ำเสนอข่าวสารแบบ

วดิโีอของเว็บ Youtube, เวบ็ไซต์ของสถานโีทรทศัน์ออกอากาศแบบความละเอยีดสูง Full HD หรอืแม้กระทั่ง

ไฟล์มลัตมิเีดยีความละเอยีด 4K (Super HD) เป็นต้น

เราเหน็เวบ็ไซต์มากมายที่ผู้ใช้เป็นเจ้าของเนื้อหาทั้งหมดอย่างแท้จรงิ เราสร้างเวบ็ไซต์ข้อมูลส่วนตวั

ของเราใน hi5, เราเป็นผู้สื่อข่าวจ�ำเป็นใน Twitter, เราสร้างสงัคมออนไลน์ของเราใน facebook, ช่วงเวลาพกั

ผ่อนของเรากข็ยีน Blog บนัทกึเรื่องราวที่เกดิขึ้น ฯลฯ

ที่ส�ำคญัอกีประการหนึ่งกค็อื องค์กร W3C สร้างมาตรฐานของภาษา HTML ใหม่เข้าสู่เวอร์ชนั 5.0 

เป้าหมายของภาษา HTML 5.0 คอื การน�ำเสนอข้อมูลที่นอกเหนอืไปจากข้อความและรูปภาพนั่นคอื ข้อมูล

มลัตมิเีดยีต่างๆ นั่นเอง 

ตั้งแต่ยคุบกุเบกิจนกระทั่งปัจจบุนั การน�ำเสนอข้อมลูมลัตมิเีดยีต่างๆ ในหน้าเวบ็เพจเป็นหน้าที่ของ 

Flash มาโดยตลอด ภาษา HTML 5.0 ก�ำลงัจะเข้ามาท�ำหน้าที่นี้ โดยมบีราวเซอร์ยกัษ์ใหญ่ในปัจจบุนัทั้งหมด 

สนบัสนนุมาตรฐานของ HTML 5.0

ยุคที่ 4 Web 2.0 (Rich Internet Application-RIA)
เราก�ำลงัเข้ามาสู่ยคุปลายของ Web 2.0 ไม่มใีครบอกได้ว่าเป็นเมื่อใด ไม่มใีครเป็นผู้ก�ำหนดได้ว่า 

Web 3.0 ต้องประกอบไปด้วยอะไรบ้าง บอกได้แต่เพยีงว่าควรจะมอีะไรบ้าง ผู้เขยีนเองกเ็ช่นกนั เป็นเพยีงคนๆ 

หนึ่งที่ยงัเสพข่าวสารอยู่ รบัรู้แต่เพยีงว่าเวบ็ไซต์ที่พบเหน็ “อลงัการงานสร้างอกีแล้ว”
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ภาษา ASP.NET คืออะไร
ส�ำหรบัผู้อ่านที่เคยสร้างเวบ็ไซต์ด้วยภาษา HTML ไม่เคยเขยีนโปรแกรม ไม่ว่าจะเป็นใน Windows 

หรอืในเวบ็กต็าม ย่อมเกดิค�ำถามขึ้นมาว่าท�ำไมการสร้างเวบ็ไซต์จงึต้องมกีารเขยีนโปรแกรม

ผูอ่้านต้องไม่ลมืว่าเวบ็ไซต์ที่สร้างมาจากภาษา HTML ไม่สามารถตอบสนองความต้องการของผูอ่้าน

ได้ทกุอย่าง ผู้อ่านสามารถท�ำลงิค์เชื่อมโยง, แทรกรูปภาพ, ก�ำหนดสขี้อความต่างๆ, ก�ำหนดสพีื้นหลงั ฯลฯ ได้ 

แต่ในบางครั้งผู้อ่านอาจจะเคยตั้งค�ำถามขึ้นมาว่า เวบ็ที่รบัสมาชกิท�ำอย่างไร, เวบ็ขายของท�ำอย่างไร เป็นต้น

เหน็ได้ว่าความต้องการของผู้อ่านเพิ่มมากขึ้นเรื่อยๆ จงึเป็นที่มาของภาษาต่างๆ ในยคุที่ 2 นั่นเอง 

ที่ต้องเพิ่มเติมความสามารถของตัวภาษาขึ้นมาเพื่อรองรับกับความต้องการต่างๆ เหล่านี้ เว็บไซต์ที่เกิดจาก

ภาษา HTML เพยีงอย่างเดยีวเดนิทางมาถงึขอบเขตของมนัแล้ว ส่งผลให้ผู้อ่านต้องศกึษาการเขยีนโปรแกรม 

ส�ำหรบัท�ำเวบ็ไซต์ไปโดยปรยิาย

อปุสรรคอย่างแรกของผู้อ่านที่ยงัไม่เคยเขยีนโปรแกรมมาก่อนเลยนั่นคอื ไม่ทราบกฎ กตกิาของตวั

ภาษา รวมถงึไม่ทราบว่าจะเริ่มต้นอย่างไร นั่นจงึเป็นที่มาของหนงัสอืเล่มนี้

ผูอ่้านที่เป็นมอืใหม่เริ่มต้นสร้างเวบ็ไซต์ที่เตม็ไปด้วยเทคโนโลยต่ีางๆ มากมายที่เกดิขึ้นมาในปัจจบุนั  

จงึเกดิปัญหาที่ไม่รู้จกัว่า ค�ำศพัท์ที่ได้ยนิคอือะไร ? ท�ำหน้าที่อะไร ? เราควรที่จะศกึษาหรอืไม่ ? หรอืเกี่ยวข้อง

กบัเราหรอืเปล่า ? ล้วนแล้วแต่เป็นค�ำถามที่มอืใหม่ต้องการทราบ

หน้าที่ของหนังสือเล่มนี้ไม่สามารถบอกทุกสิ่งทุกอย่างของการท�ำเว็บไซต์ แต่สามารถบอกมือใหม่

ได้ว่า ผู้อ่านก�ำลงัอยู่ ณ ต�ำแหน่งใดของโลกอนิเทอร์เนต็ ผู้อ่านก�ำลงัท�ำอะไรอยู่ อาจจะไม่ได้ลงรายละเอยีด 

ครบถ้วน แต่อย่างน้อยที่สุดผู้เขียนอยากให้เป็นจุดเริ่มต้นที่ดี รายละเอียดหรือเนื้อหาที่ไม่ได้กล่าวถึงก็ขอให้ 

ผู้อ่านค้นคว้าจากแหล่งอื่นๆ เพิ่มเตมิเพื่อให้ครบถ้วนยิ่งขึ้น

ภาษา ASP.NET เป็นภาษาที่ท�ำงานฝั่งเซริ์ฟเวอร์เรยีกว่า Server Side Script เป็นของไมโครซอฟท์ ใน

ปัจจบุนัคอื ASP.NET 4.0 หมายความว่า เป็นภาษาที่รนับน .NET Framework 4.0 ซึ่งมาพร้อมกบั Visual Studio 

2010 ผู้อ่านสามารถเขยีน ASP.NET 4.0 ได้ 2 ภาษาคอื

�� �ภาษา VB 2010

�� �ภาษา VC# 2010

เมื่อผู้อ่านสร้างเวบ็ไซต์ด้วย ASP.NET แล้ว สครปิต์ของ ASP.NET ถูกส่งไปประมวลผลที่ฝั่ง Server 

ก่อนจากนั้นจะส่งกลับมายังบราวเซอร์ ในรูปแบบของภาษา HTML เพื่อแสดงให้ผู้อ่านเห็นเป็นหน้าเว็บเพจ 

ดงัรูปที่ 1-1

 รูปที่ 1-1
ขั้นตอนการท�ำงานของ
สคริปต์ ASP.NET

1. สคริปต์ *.ASPX
Web Server (IIS)

บราวเซอร์ (IE)

2. แปลคำ�สั่งในสคริปต์ *.ASPX

3. HTML ที่ได้รับจากการแปล

   สคริปต์ *.ASPX
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จากรูปที่ 1-1 เหน็ได้ว่าองค์ประกอบของสครปิต์ ASP.NET ประกอบด้วยการท�ำงาน 3 ขั้นตอนคือ 

1)	 Web Server ที่ท�ำหน้าที่แปลภาษาสครปิต์ ASP.NET คอื IIS (Internet Information Services)

2)	 สครปิต์ภาษา ASP.NET (*.aspx)

3)	 บราวเซอร์ท�ำหน้าที่แสดงผลจากภาษา HTML ที่ได้จากการแปลภาษาสครปิต์ ASP.NET

ถ้าจะกล่าวในเชงิเทคนคิสกัเลก็น้อย สามารถสรปุได้ว่า

�� �ผู้ใช้ (ฝั่ง Client) ร้องขอ (Request) เวบ็เพจ (*.aspx) ไปยงั Web Server (ฝั่ง Server)

�� �Web Server (ฝั่ง Server) แปลสครปิต์ ASP.NET ได้ผลลพัธ์เป็น HTML ตอบสนอง (Response) 

มายงัผู้ใช้ (ฝั่ง Client) แสดงผลในบราวเซอร์

การก�ำหนดให้ VS 2010 แสดงไดอะล็อกบ็อกซ์ Show 
New Project dialog box

ไม่ว่าผู้อ่านจะใช้ VS 2010 Edition ใดกต็าม ต้องมกีารก�ำหนดค่าให้กบั VS 2010 เลก็น้อยเพื่อให้

เหมาะสมกบัการใช้งานกล่าวคอื ทกุๆ ครั้งที่ผูอ่้านเปิดโปรแกรม VS 2010 ขึ้นมา ควรจะมไีดอะลอ็กบอ็กซ์ Show 

New Project dialog box ปรากฏขึ้นมา เพื่อแสดงโปรเจก็ต์ชนดิต่างๆ ให้ผู้อ่านเลอืกใช้งาน ซึ่งมขีั้นตอนดงันี้

1.	 เปิด VS 2010 ขึ้นมา คลกิเมนู Tools > Options... 

 รูปที่ 1-2
การคลิกเมนู Tools > 
Options...

คลิก1
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2.	 ที่หวัข้อ Environment  คลกิเลอืก Startup ที่ช่อง At startup: คลิกเลอืก Show New Project 

dialog box

ทุกๆ ครั้งที่ผู้อ่านเปิดโปรแกรม VS 2010 ขึ้นมากจ็ะมไีดอะลอ็กบอ็กซ์ Show New Project dialog box 

ปรากฏขึ้นมาเป็นล�ำดบัแรก ให้ผู้อ่านเลอืกชนิดโปรเจก็ต์ที่ต้องการใช้งานดงัรูป

 รูปที่ 1-3
การเลือกรายการ 
Show New Project 
dialog box

เลือก2.2

คลิก2.1

จากรูปที่ 1-4 ขอบเขตของหนงัสอืเล่มนี้ต้องการพฒันาเวบ็แอพพลเิคชนัด้วย ASP.NET 4.0 (รันบน 

.NET Framework 4.0) จงึเลอืกหวัข้อ Web โดยที่

�� �Visual Basic หมายถงึ ใช้ภาษา VB 2010 

�� �Other Languages หมายถงึ ใช้ภาษาอื่นๆ ในกรณนีี้คอื ภาษา VC# 2010

 รูปที่ 1-4
ไดอะล็อกบ็อกซ์ Show 
New Project dialog 
box
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การก�ำหนดให้ Editor ของ VS 2010 แสดงหมายเลข
บรรทัด

 การก�ำหนดให้ Editor ของ VS 2010 แสดงหมายเลขบรรทดัเพื่อให้ง่ายในการปรบัปรงุแก้ไขการท�ำงาน 

ของโค้ด โดยผู้อ่านสามารถก�ำหนดได้โดยคลกิเมนู Tools > Options... คลกิเลอืก Text Editor > All Languages 

คลกิเลือก Line numbers 

 รูปที่ 1-5
กรณีเลือกใช้ภาษา 
VC# 2010

 รูปที่ 1-6
การคลิกเลือก Line 
numbers

คลิก 1

เลือก 2

คลิก3

 รูปที่ 1-7
แสดงหมายเลขบรรทัด
ใน Editor ของ 
VS 2010
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ท�ำความรู้จักกับโปรเจ็กต์ด้าน Web ของ VS 2010
VS 2010 มโีปรเจก็ต์ที่เกี่ยวข้องกบัการท�ำเวบ็ด้วย ASP.NET หลายประเภท เรยีกว่า Project Template 

เราจะมาท�ำความรู้จกัขั้นต้นว่า โปรเจก็ต์แต่ละประเภทของ VS 2010 ด้านเวบ็มอีะไรบ้าง

Project Template ด้านเว็บแต่ละประเภทของ ASP.NET 4.0 ก�ำหนดโครงสร้างโปรเจ็กต์เริ่มต้นให้ 

ผู้อ่านไม่เหมอืนกนั อย่างน้อยที่สดุการเลอืกใช้ Project Template ที่ใกล้เคยีงกบัความต้องการของเรามากที่สดุ 

ย่อมจะเป็นจดุเริ่มต้นที่ด ีดงัต่อไปนี้

1.	 ASP.NET Web Application เหมาะสมกบัผูท้ี่เคยใช้งาน ASP.NET เวอร์ชนัก่อนๆ มาบ้าง ประกอบ

ไปด้วย

�� �การสร้างเวบ็ไซต์โดยใช้โครงสร้างเวบ็ไซต์แบบ Master Page

�� �สามารถเรยีกใช้ jQuery เวอร์ชนั 1.4.1

2.	 ASP.NET MVC 2 Web Application เป็นสภาพแวดล้อมของการพฒันาเวบ็เตม็รูปแบบประกอบ

ไปด้วย

�� �การสร้างเวบ็ไซต์โดยใช้โครงสร้างแบบ MVC (Model-View-Controller) ที่มากบั VS 2010 คอื 

MVC Framework 2.0

�� �สามารถเรยีกใช้ jQuery เวอร์ชนั 1.4.1

�� �พร้อมใช้เทคนคิการประมวลผลแบบ Ajax 

3.	 ASP.NET Empty Web Application เป็นโปรเจก็ต์ว่างเปล่าเหมาะสมกบัผูใ้ช้มอืใหม่ที่ไม่เคยใช้งาน 

ASP.NET มาก่อนเลย

4.	 ASP.NET MVC 2 Empty Web Application เป็นโปรเจ็กต์ว่างเปล่าเช่นกันแต่โครงสร้างของ 

โปรเจก็ต์เป็นแบบ MVC 2.0 Framework

 รูปที่ 1-8
ไดอะล็อกบ็อกซ์ New 
Project
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ท�ำความรู้จักกับโปรเจ็กต์ชนิด ASP.NET Empty Web 
Application

Project Template ชนดิ ASP.NET Empty Web Application เป็นสภาพแวดล้อมที่ VS 2010 ไม่มกีาร

ก�ำหนดโครงสร้างใดๆ ทั้งสิ้นให้กบัผู้อ่าน เมื่อต้องการใช้งานอะไรผู้อ่านต้องเป็นผู้เพิ่มเข้ามาในโปรเจก็ต์เอง

จากรูปที่ 1-9 พบว่าที่หน้าต่าง Solution Explorer มีเพียงไฟล์ Web.Config เพียงไฟล์เดียวอยู่ใน 

โปรเจก็ต์ สิ่งที่ผู้อ่านต้องท�ำในขั้นต้นดงันี้

1.	 การเพิ่มเว็บฟอร์มเข้ามาในโปรเจ็กต์ สามารถท�ำได้โดยคลกิเมนู Project > Add New Item... และ

เลอืกไอคอน Web Form

 รูปที่ 1-9
สภาพแวดล้อมของ 
ASP.NET Empty 
Web Application

 รูปที่ 1-10
การเพิ่มเว็บฟอร์มเข้า
มาในโปรเจ็กต์ปัจจุบัน

คลิก1.1
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จากรูปที่ 1-10 เวบ็ฟอร์มแรกที่เริ่มต้น หรอืเป็นหน้าแรกในโฮมเพจของเราควรตั้งชื่อว่า Default.aspx 

ส่วนเวบ็ฟอร์มหน้าอื่นๆ กแ็ล้วแต่ความต้องการ

2.	 การเพิ่มโฟลเดอร์พิเศษต่างๆ ของ ASP.NET 4.0 เพื่อใช้ในโฮมเพจ โดยปกติแล้วการสร้าง 

เวบ็ไซต์ขึ้นมาจะต้องมกีารสร้างโฟลเดอร์ต่างๆ ขึ้นมาเพื่อท�ำหน้าที่เฉพาะอย่าง เช่น เกบ็รปูภาพ, 

เกบ็สครปิต์ต่างๆ, เกบ็ฐานข้อมูล เป็นต้น 

ใน ASP.NET 4.0 ถอืว่าโฟลเดอร์เหล่านี้เป็นโฟลเดอร์พเิศษที่หน้าต่าง Solution Explorer ซึ่งสามารถ

เพิ่มเข้ามาในโปรเจก็ต์ได้โดยเลอืกชื่อโปรเจก็ต์ คลกิขวาแล้วเลอืกค�ำสั่ง Add > Add ASP.NET Folder เพื่อสร้าง

โฟลเดอร์พเิศษขึ้นมาในโปรเจก็ต์ ดงันี้

 รูปที่ 1-10 (ต่อ)
การเพิ่มเว็บฟอร์มเข้า
มาในโปรเจ็กต์ปัจจุบัน

 รูปที่ 1-11
แสดงการเพิ่มโฟลเดอร์ 
App_Themes เข้ามา
ในโปรเจ็กต์

เลือก1.3

คลิก1.2

คลิก1.5ตั้งชื่อ1.4

คลิกขวา 2.1

เลือก2.2
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หน้าที่โฟลเดอร์แต่ละประเภทผู้เขยีนจะกล่าวถงึอกีครั้งเมื่อมกีารใช้งานหรอืเนื้อหาเกี่ยวข้อง

3.	 ที่ไฟล์ Web.Config มสีิ่งที่ควรแก้ไขกค็อื ในขณะที่โปรเจก็ต์อยู่ระหว่างพฒันายงัไม่เสรจ็สมบูรณ์ 

ให้ผู้อ่านก�ำหนดแอตทรบิวิต์ debug=“true” เพื่อให้ VS 2010 มกีาร debugging โค้ดท�ำงานใน

ขณะที่รนัโปรเจก็ต์ด้วย

 รูปที่ 1-11 (ต่อ)
แสดงการเพิ่มโฟลเดอร์ 
App_Themes เข้ามา
ในโปรเจ็กต์

WebMatrix Platform
อกีช่องทางหนึ่งที่ผูอ่้านสามารถเรยีกใช้ ASP.NET 4.0 นอกเหนอืไปจากการตดิตั้ง Visual Studio 2010 

ตามปกตนิั่นคอื โครงการ WebMatrix ของไมโครซอฟท์

WebMatrix เป็นช่องทางที่ไมโครซอฟท์ต้องการให้นกัพฒันา Web Application มคีู่มอืน�ำทางที่ดี ไม่

ว่าจะเป็นการติดตั้งเครื่องมือในการพัฒนา, การติดตามความคืบหน้าล่าสุดต่างๆ ที่เกี่ยวข้อง เห็นได้ว่าเป็น 

ค�ำถามที่ผูอ่้านคุน้เคยกนัเป็นอย่างดไีม่ว่าจะเป็นเราต้องตดิตั้งอะไรบ้าง ?, โปรแกรมที่ตดิตั้งอยูใ่นเครื่องของเรา

เป็นเวอร์ชนัล่าสดุแล้วหรอืยงั ? หรอืแม้กระทั่งมอืใหม่ที่ไม่ทราบว่าต้องเริ่มต้นอย่างไร WebMatrix มคี�ำตอบให้ 

ซึ่งมขีั้นตอนการใช้งาน ดงันี้

1.	 เข้าเวบ็ไซต์ www.asp.net/webmatrix คลกิไอคอนของโครงการ WebMatrix เพื่อดาวน์โหลดตวั

ตดิตั้งผ่านเวบ็ หมายความว่า เครื่องของผู้อ่านต้องเชื่อมต่อกบัอนิเทอร์เนต็เพื่ออพัเดตเครื่องให้ 

มคีวามทนัสมยัได้ตลอดเวลา โดยที่ไมโครซอฟท์เป็นผู้น�ำทาง ดงันี้

 รูปที่ 1-12
การก�ำหนดแอตทริบิวต์ 
debug เท่ากับ true

 รูปที่ 1-13
การดาวน์โหลดและ
ติดตั้ง WebMatrix ใน
เครื่องของผู้เขียน

ผู้อ่านจะก�ำหนดค่าแอตทริบิวต์ 

debug เท่ากับ false ก็ต่อเมื่อโปรเจ็กต์ได้

พฒันาเสรจ็สมบูรณ์ไม่มกีารแก้ไขอกีแล้ว

กรอก URL1.1

คลิก1.2
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 รูปที่ 1-14
กรณีเลือก Install 
WebMatrix

2.	 การตดิตั้งโปรแกรมและคอมโพเนนต์ต่างๆ เท่าที่ปัจจบุนัมอียู่สามารถท�ำได้ 2 วธิคีือ

�� �Install WebMatrix เพื่อดาวน์โหลดและตดิตั้งโปรแกรม, คอมโพเนนต์ต่างๆ ที่ไมโครซอฟท์ก�ำหนด

ไว้ให้ในขั้นต้นว่าควรจะตดิตั้งอะไรบ้าง มผีลดใีนแง่ที่ว่าถ้าผู้อ่านเป็นผู้ใช้มอืใหม่แล้วไม่ทราบว่า 

ต้องตดิตั้งอะไรบ้าง ทางเลอืกนี้เป็นค�ำตอบที่ดสี�ำหรบัผู้อ่าน

 รูปที่ 1-13 (ต่อ)
การดาวน์โหลดและ
ติดตั้ง WebMatrix ใน
เครื่องของผู้เขียน

คลิก 1.3

คลิก2.3

คลิก 2.2

คลิก 2.1
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 รูปที่ 1-15
กรณีเลือก 
Customize

จากรปูที่ 1-14 รายการที่ตดิตั้งขึ้นอยูก่บัว่า เครื่องของผูอ่้านในปัจจบุนัมกีารตดิตั้งอะไรอยูบ้่างกจ็ะมี

การอพัเดตโปรแกรมต่างๆ เท่าที่เกี่ยวข้องให้โดยอตัโนมตั ิการอพัเดตผ่านทาง Web Matrix มผีลกบั VS 2010 

ของผู้อ่านด้วยเช่นกนั

�� �Customize เป็นการเลอืกโปรแกรมและส่วนประกอบ, คอมโพเนนต์ต่างๆ ที่ต้องการตดิตั้งในเครื่อง 

ซึ่งผู้อ่านต้องทราบข้อมูลข่าวสารพอสมควรว่า สิ่งที่สนใจต้องตดิตั้งอะไรบ้าง ผู้อ่านควรตดิตาม

ข่าวสารของ ASP.NET อยู่เสมอ แม้ว่า ASP.NET 4.0 เป็นเวอร์ชันหลกัที่ออกมากบั .NET 4.0 

กต็าม แต่กจ็ะมกีารอพัเดตตวัภาษา, องค์ประกอบอยู่ตลอดเวลา

คลิก 1

จากรูปที่ 1-15 แน่นอนว่าต่อไปในอนาคตรายการตัวเลือกต่างๆ ย่อมที่จะแตกต่างไปจากขณะที่ 

ผูเ้ขยีนแต่งต้นฉบบัหนงัสอืเล่มนี้ แต่ประเดน็ที่ต้องการน�ำเสนอกค็อื ช่องทางที่นกัพฒันา Web Application ด้วย 

.NET Framework ควรจะทราบไว้ก่อนว่า ความก้าวหน้าในปัจจุบันมีตลอดเวลา โดยเฉพาะอย่างยิ่งผู้อ่านที่

ต้องการเป็นผู้พฒันาเวบ็กต็้องตื่นตวัอยู่ตลอดเวลาเพื่อต้อนรบัสิ่งใหม่ๆ อยู่เสมอ

คลิก2

เลือก 3

คลิก4
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ท�ำความรู้จักกับ VS 2010 IDE แบบ Web Application
เราจะมาลองท�ำความรู้จกักบัสภาพแวดล้อมของ VS 2010 แบบ Web Application ในขั้นตอนดงัรูป

1.	 แถบ Toolbox เป็นแถบเครื่องมอืเกบ็เวบ็คอนโทรลต่างๆ ที่ผูอ่้านสามารถเรยีกใช้งานได้ แยกออก

เป็นแต่ละแทบ็ตามหน้าที่

2.	 แถบ Server Explorer ท�ำหน้าที่แสดงการเชื่อมต่อกบัฐานข้อมูล SQL Server ที่ผู้อ่านเคยตดิต่อ 

หรอืเคยใช้งานกบัโปรเจก็ต์ปัจจบุนั 

 รูปที่ 1-16
สภาพแวดล้อมของ 
VS 2010 แบบ Web 
Application

Solution Explorerโค้ดและส่วนแสดงผล	

แถบ Toolbox Propertiesแถบ Server Explorer

 รูปที่ 1-17
แถบ Server Explorer

จากรูปที่ 1-17 พบว่าโปรเจก็ต์ปัจจบุนัเคยตดิต่อกบัฐานข้อมูล Northwind
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3.	 โค้ดและส่วนแสดงผลของเว็บฟอร์ม เป็นพื้นที่ส�ำหรบัแสดงผลของแต่ละเวบ็เพจที่ผู้อ่านเป็น

ผู้ออกแบบขึ้นมา แบ่งออกเป็น 3 แบบคอื

�� �Design หมายถงึ แสดงเวบ็เพจในโหมดออกแบบ 

�� �Split หมายถงึ แสดงเวบ็เพจในโหมดออกแบบและแสดงโค้ดด้วย โดยการแบ่งหน้าจอออก

เป็น 2 ส่วน

�� �Source หมายถงึ แสดงโค้ดของเวบ็เพจปัจจบุนั

4.	 หน้าต่าง Solution Explorer ท�ำหน้าที่แสดงโครงสร้างเว็บเพจและรายการโฟลเดอร์ต่างๆ ของ 

โปรเจก็ต์ปัจจบุนัที่เปิดขึ้นมา

5.	 หน้าต่าง Properties หมายถึง คณุสมบตัติ่างๆ ของคอนโทรล, อลิเิมนต์ หรอืออบเจก็ต์ปัจจบุนั

ที่ก�ำลงัโฟกสัอยู่

การก�ำหนดเว็บฟอร์มเริ่มต้น
โดยปกติแล้วการสร้างเว็บไซต์ขึ้นมาย่อมที่จะประกอบไปด้วยเว็บฟอร์มหลายเว็บฟอร์มในเวลา

เดยีวกนั โดยปกตแิล้วมกัที่ก�ำหนดให้เวบ็ฟอร์ม Default.aspx เป็นหน้าแรก เป็นหน้าเริ่มต้นของเวบ็ไซต์ 

แต่ถ้าผูอ่้านต้องการก�ำหนดให้เวบ็ฟอร์มอื่นเป็นเวบ็ฟอร์มเริ่มต้น สามารถท�ำได้โดยคลกิขวาแล้วเลอืก

ค�ำสั่ง Set As Start Page เพื่อก�ำหนดให้เวบ็ฟอร์มดงักล่าวเป็นเว็บฟอร์มเริ่มต้นดงัรูป

จากรูปที่ 1-18 เมื่อผู้อ่านสั่งรันโปรเจ็กต์เว็บฟอร์มที่ชื่อว่า Products.aspx จะถูกสั่งให้รันขึ้นมาเป็น

ล�ำดบัแรก

 รูปที่ 1-18
การก�ำหนดให้เว็บฟอร์ม
ที่ชื่อว่า Products.
aspx เป็นฟอร์มเริ่มต้น คลิกขวา1

เลือก2
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ท�ำความรู้จักกับโครงสร้างเบื้องต้นของโปรเจ็กต์ชนิด 
ASP.NET 4.0

โค้ดการท�ำงานของภาษา VB 2010 เกบ็อยู่ในไฟล์ *.vb ส่วนภาษา VC# 2010 เกบ็อยู่ในไฟล์ *.cs 

ของแต่ละโปรเจก็ต์แสดงอยู่ในหน้าต่าง Solution Explorer 

จากรูปที่ 1-19 ให้ผู้อ่านคลกิปุ่ม  เพื่อแสดงรายการไฟล์ทั้งหมดของโปรเจก็ต์ปัจจบุนั โดยที่

�� �ไฟล์ Default.aspx ท�ำหน้าที่เป็นส่วนแสดงผลในหน้าเว็บเพจ สครปิต์ต่างๆ ที่เกดิขึ้นในไฟล์นี้เกดิ

จากการเรยีกใช้งานเวบ็คอนโทรลต่างๆ ถูกสร้างขึ้นมาโดยอตัโนมตัดิ้วย VS 2010

 รูปที่ 1-19
รายการไฟล์ที่ปรากฏใน
หน้าต่าง Solution 
Explorer ของ ASP.NET 4.0 
ของภาษา VB 2010

 รูปที่ 1-20
แสดงแท็บ Source

ถ้าผู้อ่านโฟกสัที่ไฟล์นามสกลุ *.aspx ในหน้าต่าง Solution Explorer แล้วคลกิแทบ็ Source เป็นการ

แสดงสครปิต์ ASP.NET ของไฟล์ *.aspx ที่ผู้อ่านเลอืก

�� �ไฟล์ Default.aspx.vb (หรอืไฟล์ Default.aspx.cs) ท�ำหน้าที่เกบ็โค้ดการท�ำงานของภาษา VB 2010 

เป็นพื้นที่ที่ผู้อ่านต้องเขยีนโค้ดขึ้นมานั่นเอง ส่วนโปรเจก็ต์แบบภาษา VC# 2010 มลีกัษณะเช่น

เดยีวกบัแบบภาษา VB 2010 แตกต่างกนัตรงที่ว่า ไฟล์ที่เกบ็โค้ดการท�ำงานมนีามสกลุ *.cs นั่นคอื 

Default.aspx.cs เราเรยีกโครงสร้างโค้ดดงักล่าวว่า การเขยีนโค้ดแบบ Code-Behind
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ความแตกต่างระหว่างสครปิต์ ASP.NET 4.0 (*.aspx) ของภาษา VB 2010 กบัภาษา VC# 2010 นั่นคอื 

การอ้างองิไฟล์ที่เกบ็โค้ดท�ำงานที่ระบไุว้ในบรรทดัแรกดงัรูป

ข้อแตกต่างกค็อื การอ้างองิไฟล์ที่เกบ็โค้ดท�ำงานในไฟล์ *.aspx จะอ้างองิตามชื่อไฟล์ของภาษานั้นๆ 

เช่น ภาษา VB 2010 ระบไุฟล์นามสกลุ *.vb ส่วนภาษา VC# 2010 ระบไุฟล์นามสกลุ *.cs

ผู้เขียนขอละในฐานที่เข้าใจว่า ถ้ามีการลงสคริปต์ของ ASP.NET 4.0 (*.aspx) จะลงแต่เฉพาะ 

ส่วนที่เกี่ยวข้องกับโค้ดท�ำงานเท่านั้น แต่ขอให้ผู้อ่านทราบว่า มีความแตกต่างกันเฉพาะบรรทัดแรกเท่านั้น 

ดงัตวัอย่างต่อไปนี้

ASP.NET 4.0

<body>
    <form id="form1" runat="server">
    <div>
       ...
    </div>
    </form>
</body>

ตวัอย่างสครปิต์ข้างต้น หมายความว่า ต้องการแสดงสครปิต์บางส่วนที่มคีวามส�ำคญัในไฟล์ *.aspx 

ที่ผู้เขียนคาดว่าเกี่ยวข้องกับโค้ดการท�ำงาน ซึ่งอยู่ระหว่างอิลิเมนต์ <body>...</body> เท่านั้น ผู้เขียนขอละ

ในฐานเข้าใจที่ว่าสครปิต์บรรทดัอื่นๆ ที่ไม่ได้น�ำมาแสดงในหนงัสอืไม่มคีวามเกี่ยวข้อง หรอืไม่มผีลมากนกัต่อ

ประเดน็ที่น�ำเสนอ

ส่วนข้อความที่ก�ำกับกรอบสี่เหลี่ยมบอกให้ผู้อ่านทราบว่า โค้ดหรือสคริปต์ที่อยู่ในกรอบสี่เหลี่ยม 

ดงักล่าวเป็นของสครปิต์ ASP.NET 4.0 หรอืภาษา VB 2010 หรอื VC# 2010 ฯลฯ ท�ำให้ผู้อ่านแยกแยะได้ว่า 

โค้ดที่ลงในหนงัสอืหมายถงึโค้ดส่วนใด

 รูปที่ 1-21
การอ้างอิงไฟล์เก็บโค้ด
การท�ำงานระหว่าง
ภาษา VB 2010 กับ
ภาษา VC# 2010 ที่
บรรทัดแรก

ส่วนที่แตกต่างกัน
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ข้อแตกต่างที่ส�ำคัญอีกประการหนึ่งคือ เหตุการณ์ของเว็บคอนโทรลต่างๆ ที่ผู้อ่านใช้งานมีความ 

แตกต่างกนัระหว่างภาษา VB 2010 กบั VC# 2010 เลก็น้อยกล่าวคอื

เมื่อผู้อ่านดบัเบลิคลกิที่เวบ็คอนโทรล Button ส่งผลให้ VS 2010 สร้างเหตกุารณ์ Button1_Click() ขึ้น

มาให้ผู้อ่านในไฟล์ Default.aspx.vb (.cs) 

 รูปที่ 1-22
การเรียกใช้เว็บ
คอนโทรล Button ของ 
ASP.NET 4.0

ข้อแตกต่างที่เกดิขึ้นในสครปิต์ของ ASP.NET 4.0 (*.aspx) นั่นคอื ในภาษา VC# 2010 มกีารอ้างองิ

เหตกุารณ์ Button1_Click() ไว้ด้วย ส่วนภาษา VB 2010 ไม่มกีารอ้างองิแต่อย่างใดจงึเป็นข้อแตกต่างระหว่าง

สครปิต์ ASP.NET 4.0 ของทั้ง 2 ภาษา

 รูปที่ 1-23
แสดงโค้ดท�ำงานของ
เหตุการณ์ Button1_
Click() ของภาษา VB 
2010 และภาษา VC# 
2010

 รูปที่ 1-24
การอ้างอิงเหตุการณ์ 
Button1_Click ในไฟล์ 
*.aspx ระหว่างภาษา 
VB 2010 กับภาษา 
VC# 2010
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วิธีการทดสอบตัวอย่างสคริปต์ของ ASP.NET 4.0
สมมตวิ่าโปรเจก็ต์ที่ผู้อ่านสนใจเกบ็อยู่ที่พาธ C:\ มวีิธทีดสอบสครปิต์ ASP.NET 4.0 ที่น่าสนใจอยู่ 

2 วธิคีอื

�� �กรณีที่ 1 โปรเจก็ต์ดงักล่าวมไีฟล์ Solution (*.sln)

1.	 ดบัเบลิคลกิไฟล์ *.sln เพื่อเปิดโปรเจก็ต์ชนดิ Web Application ใน VS 2010 

 รูปที่ 1-24 (ต่อ)
การอ้างอิงเหตุการณ์ 
Button1_Click ในไฟล์ 
*.aspx ระหว่างภาษา 
VB 2010 กับภาษา 
VC# 2010

 รูปที่ 1-25
กรณีการเปิด Web 
Application ใน 
VS 2010

 รูปที่ 1-26
แสดงเว็บฟอร์มของ
โปรเจ็กต์ปัจจุบัน

ดับเบิลคลิก

เหตุการณ์ Click() ใน VC #

2.	 แสดงรายชื่อเว็บฟอร์มของโปรเจ็กต์ปัจจุบันที่แสดงอยู่ในหน้าต่าง Solution Explorer ของ 

VS 2010 IDE 
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�� �กรณีที่ 2 โปรเจก็ต์ดงักล่าวไม่มไีฟล์ Solution มแีต่รายชื่อไฟล์ของ ASP.NET เช่น *.vb, *.cs, 

*.aspx ฯลฯ ให้ผู้อ่านเปิด VS 2010 แบบว่างเปล่าขึ้นมาก่อน จากนั้นคลกิเมนู File > Open 

Web Site... เลอืกพาธที่จดัเกบ็ไฟล์ต่างๆ ของ ASP.NET สมมตวิ่าจัดเกบ็อยู่ที่พาธ C:\PageEvent

การทดสอบสครปิต์ ASP.NET 4.0 ทั้ง 2 วธิรีนัภายใต้ ASP.NET Development Server โดยที่ไม่จ�ำเป็น

ต้องอาศัย IIS แต่อย่างใด ซึ่งมีความสะดวกต่อนักพัฒนาเป็นอย่างยิ่ง เพราะว่าผู้อ่านสามารถทดสอบผล 

การท�ำงานได้ทนัที

 รูปที่ 1-27
กรณีมีแต่รายชื่อไฟล์
ของ ASP.NET 4.0

คลิก3

เลือก2

เลือก1

 รูปที่ 1-28
แสดง ASP.NET 
Development 
Server ถูกรันขึ้นมา
โดยอัตโนมัติ

จากรปูที่ 1-28 เมื่อผูอ่้านทดสอบรนัโปรเจก็ต์ 

ใน VS 2010 IDE แล้ว ASP.NET Development Server 

ถูกสั่งให้รันขึ้นมาโดยอัตโนมัติ เพื่อท�ำหน้าที่แปล 

ชดุค�ำสั่งของสครปิต์ ASP.NET 4.0 ทั้งในส่วนแสดงผล 

(*.aspx) และโค้ดการท�ำงาน (*.vb หรอื *.cs)

คลิก1

คลิก3

เลือก2
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การทดสอบสครปิต์ของ ASP.NET 4.0 ม ี2 วธิคีอื

1.	 ตัวเลือก Modify the Web.config file to enable debugging หมายถงึ ทดสอบสครปิต์ ASP.NET 

และโค้ดการท�ำงานว่า มข้ีอผดิพลาดเกดิขึ้นหรอืไม่ ถ้ามใีห้ไปยงัจดุที่เกดิข้อผดิพลาด เพื่อ debug 

ข้อผดิพลาดดงักล่าวด้วย

2.	 ตัวเลือก Run without debugging หมายถงึ ทดสอบสครปิต์ ASP.NET และโค้ดการท�ำงานว่า มี

ข้อผดิพลาดเกดิขึ้นหรอืไม่ ถ้ามใีห้ไปยงัจดุที่เกดิข้อผดิพลาด แต่ไม่มกีาร debug ข้อผดิพลาด 

ดงักล่าว	

ข้อแตกต่างที่ส�ำคัญของการทดสอบทั้ง 2 วิธีก็คือ ถ้าผู้อ่านมั่นใจว่า สคริปต์ ASP.NET และโค้ด

การท�ำงานของผู้อ่านท�ำงานสมบูรณ์ไม่มีอะไรต้องแก้ไขอีกแล้ว ให้เลือกรันแบบที่ 2 เพราะว่าไม่จ�ำเป็นต้อง 

debugging โค้ดการท�ำงานแต่อย่างใด

ผู้เขียนเลือกตัวเลือกที่ 2 เพื่อทดสอบโปรเจ็กต์ไม่จ�ำเป็นต้องมีการ debugging แต่อย่างใด

ในกรณีที่ผู้อ่านเลือกทดสอบแบบตัวเลือกที่ 1 ส่งผลให้เกิดการแก้ไขค่าของแอตทริบิวต์ debug=“true” ใน

ไฟล์ Web.config ผู้อ่านสามารถแก้ไขค่ากลับมาเป็น false เพื่อให้เป็นทางเลือกอย่างเดิมได้เช่นกัน ดังรูปที่ 1-29

 รูปที่ 1-29
แสดงค่าของแอตทริบิวต์ 
debug=“true”
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ความสัมพันธ์ระหว่างเว็บคอนโทรลของ ASP.NET กับ
ภาษา HTML

เมื่อผู้อ่านใช้งานเวบ็คอนโทรลต่างๆ เพื่อสร้างส่วนแสดงผลในเวบ็เพจ (*.aspx) เราจะมาดูว่า เวบ็

คอนโทรลที่ผู้อ่านใช้งานถูกแปลงเป็นภาษา HTML อย่างไร ให้ผู้อ่านดูรูปที่ 1-30 ประกอบค�ำอธบิาย

ให้ผูอ่้านคลกิแทบ็ Source พบว่า เวบ็คอนโทรลที่น�ำมาใช้งานถกูแปลงเป็นอลิเิมนต์ที่ขึ้นต้นด้วยค�ำว่า  

asp เสมอ แตกต่างจากอลิเิมนต์ของภาษา HTML แสดงด้วยชื่ออลิเิมนต์โดยตรง เช่น 

�� �อิลิเมนต์ <br /> เป็นของภาษา HTML ท�ำหน้าที่ขึ้นบรรทดัใหม่ เมื่อบราวเซอร์พบอลิเิมนต์นี้ก็

จะขึ้นบรรทัดใหม่ 1 บรรทัดต่อ 1 อิลิเมนต์ บราวเซอร์สามารถแปลหน้าที่อิลิเมนต์ของภาษา 

HTML ได้โดยตรง

�� �อิลิเมนต์ <asp:Label>...</asp:Label> เป็นอลิเิมนต์ที่เกดิจากการใช้งานเวบ็คอนโทรล Label ของ

ภาษา ASP.NET 4.0 (*.aspx) พบว่ามแีอตทรบิวิต์ที่ชื่อว่า runat=“server” ท�ำหน้าที่บอกบราวเซอร์ว่า 

อลิเิมนต์นี้รนัที่ฝั่ง server 

�� �อิลิเมนต์ <asp:Button>...</asp:Button> เป็นอลิเิมนต์ที่เกดิจากการใช้งานเวบ็คอนโทรล Button 

ของภาษา ASP.NET 4.0

หมายความว่าเวบ็คอนโทรลทกุตวัที่ผูอ่้านเรยีกใช้งานต้องแปลเป็นภาษา HTML ที่ฝ่ัง server เสยีก่อน 

แล้วค่อยส่งกลบัมาให้บราวเซอร์แสดงผลต่ออกีทหีนึ่ง

สรุปท้ายบท

ผูเ้ขยีนน�ำเสนอเนือ้หาเบือ้งต้นต่างๆ ทีเ่กีย่วข้องกบั ASP.NET 4.0 เพือ่ให้ผูอ่้านทราบว่า ผูอ่้านก�ำลงัอยูส่่วนไหน 

ของ .NET 4.0 Framework

 รูปที่ 1-30
การใช้งานเว็บ
คอนโทรล Label กับ
เว็บคอนโทรล Button 
ในสคริปต์ของ ASP.
NET 4.0


